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Welcome to Perfect Effects Free

�%�U�L�Q�J���R�X�W���W�K�H���³�:�2�:�´���L�Q���\�R�X�U���L�P�D�J�H�V���Z�L�W�K���W�K�H���W�U�D�Q�V�I�R�U�P�D�W�L�Y�H���S�R�Z�H�U���R�I���3�H�U�I�H�F�W���(�I�I�H�F�W�V�������)�U�H�H�����,�W�V
library of one-click presets, adjustable filters, and powerful tools make it easy to bring out the best in
your image. Get stunning results instantly or take complete creative control as you add subtle to
striking enhancement to your image, create a vision that you have in your mind's eye, or immerse
yourself in freeform creativity. With Perfect Effects 8 Free, you can do it all.

 



 

Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.
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Using the Help System

This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.

If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual

 You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.

http://www.ononesoftware.com/support/user_guides.html


 

Contacting onOne Software

 At onOne Software, we value our customers and offer a variety of ways to be contacted.

�‡ Visit our company website at:
   www.onOnesoftware.com

�‡��For technical support please visit: 
   www.onOnesoftware.com/support

onOne Software, Inc.

15333 SW Sequoia Parkway Suite 150 
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

�‹���������������������� onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom, Flash and Adobe Acrobat are either registered trademarks or trademarks of Adobe Systems,
Incorporated in the United States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other
countries. Microsoft, Windows, Windows Vista, Windows 8 and .NET are registered trademarks of Microsoft Corporation. All other trademarks are the property of their
respective owners. The activation system used by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file
installed with the software.

http://www.ononesoftware.com/
http://www.ononesoftware.com/support


 

Additional Help

 

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.

 

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.

 

Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

 
Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.

http://www.ononesoftware.com/support/
http://www.ononesoftware.com/support/contact-ts.html
http://www.ononesoftware.com/support
http://www.ononesoftware.com/support/#CS_Hot
http://www.ononesoftware.com/university/#!/video/welcome-to-the-onone-university


 

System Requirements

Minimum Recommended

Operating
System

Mac OSX 10.7, 10.8, 10.9 
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit only

Mac OSX 10.8, 10.9
Windows Windows 7 or Windows 8 
current maintenance releases, 64 bit

Processor Intel Core 2 Duo, Xeon or better processor(s) Quad-core Intel Core i5, Xeon or better
processors(s)

RAM 8 GB RAM 8+ GB RAM

Hard Drive 1 GB for installation 1 GB for installation 
Fast 7200 RPM or SSD drives

Display OpenGL 2.0 compatible video card with 256 MB
dedicated video RAM, 1280x720 resolution

OpenGL 4.0 compatible video card with 1GB
dedicated video RAM, 1920x1080 resolution

Optional
Application
Integration

Photoshop CS5, CS6, CC, CC 2014 
Photoshop Elements 10, 11, 12
Photoshop Lightroom 4, 5
Apple Aperture 3.4

Photoshop CS6, CC, CC 2014 
Photoshop Elements 11, 12
Photoshop Lightroom 5 
Apple Aperture 3.4

Other
Internet connection for activation, auto update
checking, content downloads and tutorials. 
Adobe Flash Player

Wacom tablet for pressure sensitive input 
Hardware display calibration tool 

 
 

About Windows Video Cards

If you are using Perfect Effects Free from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the
best performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or
more of dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.



 

Installation

To install Perfect Effects Free, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne
Software website or it may be on a DVD if you elected for a physical shipment.

 

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OSX

The application is installed in the Perfect Effects Free folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects Free is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.

Windows

The application is installed in the Perfect Effects Free directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Effects Free is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling

To uninstall Perfect Effects Free, follow these instructions. 

 
You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer. 

Mac OSX

1. Go to the Applications/Perfect Effects Free/Documentation folder.
2. Double click on the Remove Perfect Effects Free application.

Windows

1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Effects Free and then click on the Uninstall button.



 

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback
including: emails, surveys, direct conversations, market analysis and the Product Improvement Program. The Product Improvement
Program is built into our software and gathers information about how our software is used. It is the most accurate way for us learn
what features are important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted. 

You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products. 

You can learn more about the Product Improvement Program here.

http://www.ononesoftware.com/go/analytics


 

Opening and Saving Files

Supported File Types

Perfect Effects Free uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file
format that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing
applications. It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Effects Free also supports
the opening and saving of the following file types, in RGB either 8 or 16 bits per pixel.

Photoshop (PSD)
Photoshop Large Document (PSB) 
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras

Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Effects Free and are recommended as your main file format. If your saved
file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer version of
the PSD file format and still maintains all your layers and masks. 

You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files

You may open an existing file in several ways.

1. Open the file from the Open button.
2. Dragging a file onto the Perfect Effects Free icon.
3. Sending a file to Perfect Effects Free from a host application like Photoshop or Lightroom using the Perfect Effects Free plug-in.

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options

http://www.ononesoftware.com/support/1674/


When you open a file(s) in the standalone application you will be presented
with the dialog to the right. It allows you to choose to work on the original
file, a copy, or to stack the files together as layers.

Edit a Copy: A copy of the original file is made using the Copy
Options below and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites the
original file with your changes. This option is disabled for Raw or
read-only files.

If you select to open a copy, you can control the file type, color space,
bit-depth and resolution. If you have multiple files selected, they will all be
handled the same way. 

 

Saving Files

1. You may save the image you are working on by pressing the Save & Close button.



 

Using as Standalone

Perfect Effects Free can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these
steps:

Mac OSX

1. Open your Hard Drive.
2. Navigate to the Applications folder.
3. Navigate to the Perfect Effects Free folder.
4. Double click on the Perfect Effects Free application icon.

You can add Perfect Effects Free to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use
Launchpad it can be found there as well.

Windows 7

1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Effects Free.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects Free from there.

Windows 8

1. Open the Start screen by pressing the Window key.
2. Select Perfect Effects Free.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Effects Free from there.



 

Using with Adobe�Š Photoshop�Š

To use Perfect Effects Free inside of Adobe Photoshop follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on.  Perfect Effects Free works on a copy of your selected layer, not the entire image.
3. From the File menu, select Automate, then Perfect Effects Free. 

 

 To use Perfect Effects Free inside of Adobe Photoshop Elements, follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on. Perfect Effects Free works on a copy of your selected layer, not the entire image.
3. From the File menu, select Automation Tools, then Perfect Effects Free. 

 

onOne Panel

Users of Adobe Photoshop CS5 and higher can also access Perfect Effects Free as plug-ins using the onOne Extension Panel. This provides fast access to the
Perfect Effects Free and its presets. To access the onOne panel, go the Window > Extensions menu in Photoshop and select onOne. 

The onOne panel behaves just like any other panel in Photoshop. It can be minimized or nested with other panels. To access a module, simple double-click on
it. To use a preset, single click on the module name. A menu of available presets will be displayed. Simply double-click on one to apply it to your selected layer.

 
If you wish to record actions using Perfect Effects Free be sure to access it from the File > Automate menu when recording.

 



 

Using with Adobe�Š���3�K�R�W�R�V�K�R�S�Š���/�L�J�K�W�U�R�R�P�Š

Plug-In Extras

Perfect Effects Free can be accessed from the File > Plug-in Extras menu. To edit an image in Perfect Effects Free follow these steps.

1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select Perfect Effects Free

Selecting Multiple Images
If you have multiple images selected, each image is opened in turn and you may adjust the settings on an image by image basis.

 

Lightroom Plug-in Preferences 

When you use Perfect Effects Free through the Plug-In Extras menu there are
important file handling options that are controlled in the Preferences dialo. These
need to be configured in advance based on your desired workflow.

File Type: The file type drop-down menu determines what type of file will
be created. The default is PSD, which maintains layers. You can also select
JPG or TIF if you prefer those formats and are not concerned about
maintaining layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which are saved as
PSD.
Color Space: The color space drop-down menu determines what RGB
working color space is used; Adobe RGB 1998, sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the bit depth,
either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the resolution of
the file.
Stack with Original: When enabled, the new image is stacked with the
original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select a single PSD
file, it will be edited directly, rather than having a copy made.

 

External Editor

You can also access Perfect Effects Free as an external editor. You can access it from the Edit In... contextual menu. These behave similarly to the plug-ins
in the Plug-In Extras menu but ignore the preferences. Instead you have the option to control a subset of these options each time you access a module, in
the same way you do when you access Photoshop or any other external editor.

 

Lightroom Export

You can also batch process with Perfect Effects Free through the Export menu in Lightroom. This is useful if you need to remove metadata or are more
comfortable with Lightroom's Export. Batch processing through Export is driven by presets, so you need to create a preset that accomplishes the work you
desire first.

1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select Perfect Effects Free.
4. Complete the module specific options below. These will start with the preset, followed by options for selecting the export location, file naming, file

size, etc.
5. Press the export button.

 
You cannot save Lightroom export presets or use the Export with Previous option. 

 



 

Using with Apple�Š Aperture�Š 

Perfect Effects Free integrates tightly with Apple Aperture and provides a seamless experience for enhancing your images.

Perfect Effects Free can be accessed from the Photo > Edit with Plug-In menu. To edit an image in Perfect Effects Free follow these steps.

1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select Perfect Effects Free.

Selecting Multiple Images

If you have multiple images selected, each image will open in a series so you can adjust the settings on each image.
  

 

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Effects Free will
maintain the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store
re-editable layers and mask.



 

Using with Other Applications

You can use Perfect Effects Free as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application
user guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include
selecting Perfect Effects Free setting the file type to send to it. Below are the instructions for configuring iPhoto. 

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option

(note if you have ever selected another external editor, it may be
listed here instead.)

4. From the Choose dialog that appears, navigate the the Perfect
Effects Free folder, inside the Applications folder and select
[Product Name].

5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .

 



 

Managing Extras

What are Extras?

The Extras Manager let's you import and manage
your own Extras content. Extras are:

Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect Effects Free.

Extras can be content that you download from
the onOne website or content that you create on
your own.

The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.

You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

 

 

How to Import Extras

Importing extras is simple. Start by opening the Extras Manager then follow these steps.

1. Select the type of extras you wish to import in the left column (Textures, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you

want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete

3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Effects Free. You can select from an
existing category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Effects Free can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.

 

If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager. 



 

How to use in Perfect Effects Free

You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:

1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the

correct filter type, either Borders or
Texturizer.

3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.

4. From the Texture pop-up select a texture
from the category you selected.

 

 
 

How to Delete Extras

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager.
2. Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
3. To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
4. To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.

 
 Deleting extras is permanent and can not be undone!
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Preferences

#_Anchor_Introduction%20(Free)_xx_preferences


1. Working Color Space: When a new file is created or file is
opened and has no color profile associated with it, this is the
assumed color profile for the image. Images that come from
other hosts or have tagged or embedded profiles will use the
associated profile instead.

2. Scrolling Controls: Lets you select how the mouse scroll
wheel or scrolling gesture works. The options are:

1. None: Default
2. Preview Zoom: Adjusts the zoom of the preview

window. Scrolling up increases the zoom, scrolling
down decreases the zoom. It is important that the
zooming is comfortable, not too fast or slow or jerky.

3. Preview Pan: Pans the image, like using the pan
tool or navigator. It is important that the panning is
comfortable, not too fast or slow or jerky.

4. Brush Size: Adjusts the size of the current tool if
relevant, such as a brush tool.

3. Preview Background Color: You may select the color of
the background behind the preview image. The default color
is black. There should be options for black, white, light gray,
dark gray and custom... The custom option a color picker
where you can select your own background color

4. Check of Updates on Launch: Enabled by default, the
product will communicate with onOne server at launch and if
an update is available it will prompt you to download, or skip. 

 

 

1. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF (No
Layers). JPEG (No Layers).

2. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences tab,
however there are only the three options supported by
Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.

3. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16 bit.

4. Resolution: Sets the resolution of copies created by
Lightroom.

5. Stack with Original: Enabled by default, copies created by
Lightroom are stacked with their original or source image.

6. Use Original for Single PSDs: Enabled by default. If your
selection is a single PSD file, the original PSD is opened rather
than creating a copy.

 

 

 

Preferences
The preferences dialog contains general application settings. The preferences are accessed from the Perfect Effects Free menu on Mac or the Edit menu on
Windows.   

The preferences contain the following controls:

General Settings

Lightroom Plug-In Settings

 

Performance Settings



1. Memory Usage: Specifies the amount of system memory
(RAM) that is used by the application. The default is 80%.

2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.

 

 



Perfect Effects gives photographers a fast and powerful way to create images with
impact.

It includes an updated library of professional quality photographic filters that can be previewed live on
your image before being applied. Live previews are shown in full screen so you can see your image at
its best. You'll enjoy the ability to stack multiple filters together to create your own unique look.

Perfect Effects takes the idea of stacking filters further with updated blending options that provide
better control over how effects are combined. These advanced tools include blending modes options
and the ability to limit filters to specific color or tonal ranges of an image.

 

 

Perfect Effects Free



 

Getting Started
This getting started section will give you the basics of using Perfect Effects. If you have never used Perfect Effects before this is a good place to start. You can
also watch the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the Using Perfect
Effects section instead.

When to use Perfect Effects

The broad range of effects in Perfect Effects makes it useful at many steps in the digital workflow. For example, the filters in the Brightness, Contrast and Color
Correction categories may be used early in the workflow for correcting the color and tone of an image. While filters in many categories are designed for a more
artistic effect, it may be used in the middle of the process as well. Finally, Perfect Effects has several filters designed for sharpening in the Sharpening category
that should be applied as the last step before printing.

http://www.ononesoftware.com/learn/training/


 

 

User Interface
Perfect Effects Main Window:

A. Effects Browser: This library of filters is located on the left side of the window for easy browsing.
B. Tool Well: This is where the tools are located.
C. Preview Window: This is the main section where you preview and work on images.
D. Tools Option Bar: This is where information and options about each tool is set.
E. Navigator, Loupe and Histogram Pane: This pane will access the Navigational, Loupe and Histogram features.
F. Filter Stack: This is where you view and stack filters.
G. Filter Options: This is where you access the filter options pane.
H. Cancel/Apply Buttons: This is where you cancel or apply an action.

The Perfect Effects Tool Well

There are four different tools in the Perfect Effects tool well. More details about each tool will be covered in the next chapters.

 Masking Brush  This masks out areas using brush strokes to expose underlying layers.

 Masking Bug  This tool lets you mask out the layer to expose the original underlying image.

 Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  This tool changes the magnification in the preview window.

#_Anchor_Effects%20Free%20Module_xx_using_the_maskingbrush1
#_Anchor_Effects%20Free%20Module_xx_using_the_masking_bug1
#_Anchor_Effects%20Free%20Module_xx_navigating_the_preview
#_Anchor_Effects%20Free%20Module_xx_navigating_the_preview


 

Navigating the Preview
Perfect Effects Free

This provides several ways to navigate and view your image in the Preview window. 

  

The Preview Window above is the main section where you preview and work on images.

 
 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

 

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

 
Zoom Tool 

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

 

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.



 

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 



The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the
highlights. At the top of each end is a triangle. If the triangle is lit, there is clipping on that side
of the histogram. If you click on the arrows, you will activate the clipping overlay on your
image. The areas of your image with a blue overlay are pure black, while the areas with the red
overlay are pure white. You can turn the clipping view off again by clicking on one of the
triangles. You can also temporarily enable clipping view by holding down the J key at any time.
The clipping view is useful when you are making adjusts to the brightness and contrast of your
image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
 

Clipping View

 

The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 

 The Info panel is not visible when you access Perfect Effects Free as a Photoshop
plug-in.

 



The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

  

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

 

Top-Bottom Screen. Top-Bottom Split Screen.  

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.
Command (Control) L:

Command-Option (Control-Alt) L:
Command (Control) T:

Command-Option (Control-Alt) T:
Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

 

Preview Window Modes



 

Using Perfect Effects
Perfect Effects is designed to work in steps by adding and adjusting multiple effects on top of each other. If you are a photographer, think of this like adding
filters over your cameras lens. First, you would add a polarizer to increase the contrast. Next you would add a graduated neutral density filter to darken the sky
and perhaps add a vignette lens hood to darken the edges. This same concept is what drives Perfect Effects, except you have many more filters and more
flexibility and control. 

Perfect Effects provides several ways to work depending on your skill level. It works for beginners through advanced users. Below are example workflows for
different levels.

Beginner

A new user can simply click on an filter and apply it. This is the easiest way to get started.

1. Start by opening an image into Perfect Effects.
2. On the left side you will see the Browser with a list of categories. Click on a category to open up a series of filters. You will now see your image with

different filter applied. 
3. Simply click on the filter you like and press the Apply button.

Intermediate

An intermediate user may try stacking filters and adjusting their strength.

1. Start by opening an image into Perfect Effects.
2. Add a filter from the Browser, adjust its strength with the sliders in the Filter Options pane.
3. Add another filter layer by pressing the Add button in the Filter Stack pane, then select a new filter from the library.
4. Continue to add filters and adjust their settings.
5. When you have created a filter stack you like, press the Apply button.

Advanced

An advanced user may stack multiple filters, adjust the strength, blending options, filter options and use the masking tools to selectively apply filters.

1. Start by opening an image into Perfect Effects.
2. Add a filter from the Browser.
3. Adjust the filter options in the Filter Options pane. This pane contains controls relevant to the selected filter.
4. Use the blending options to control the blending mode. You can also control which color or tonal ranges are affected.
5. Continue adding effect filters, adjusting the filter options and blending options to achieve the desired look.
6. Use the masking tools to selectively apply each filter layer by painting them in or out or applying a filter as a gradient or vignette.
7. When you have created a filter stack you like, press the Apply button. You can also save a stack as a preset so it can be used again later.



 

Browsing Filters
Built into Perfect Effects is a browser, located in the left panel. You can use it to browse the factory supplied filters, presets you have created or downloaded
from the onOne website or for marking and finding your favorites. Below is a description of the controls in the browser.

 

A. Browser Tabs: This switches between filters, presets and favorites.
B. Search Field: Use the search field to locate files in the current sub-folder. Simply start to type and your results
will appear in a new sub-folder called search results while you type.
C. Filter Categories: This will list the different filter categories for you to choose from.
D. Image File: A thumbnail of the image is displayed and will have the filter applied to it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of the browser or
close it.
F. Browser Modes: These icons control the browser views. One column, two column, three column or list view.
G. Quick View Browser Button: Press this button to open the current folder in the Quick View Browser. 

Browser Tabs

The Browser is divided into three tabs; Filters, Presets and Favorites.

Filters: The Filters tab contains the factory Filters provided by onOne Software. 
Presets: When save your own presets, or install presets from the onOne website, they will be located here.
Favorites: When you click on the favorite flag on a filter or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to find
the filters and presets you use most frequently.

Navigating the Browser

To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, filter or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

 
 You cannot move or delete presets from the browser.

Selecting a Filter or Preset to Use

To activate a filter or preset on your image, simply click on it.



Searching

To search for filters or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on a filter or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four
viewing modes. Three that
display thumbnails in
columns and one list view.
The browser modes are
selected using the browser
mode icons at the bottom
of the browser.

   single column view    two column view    list view

Quick View Browser



The Quick View Browser adds an
elegant full-screen view of your
images, filters and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.

Browse folders and
images quickly to find
the right one to work on.
View all your filters or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.

 



When you add a Filter to your image, it will appear on the current Filter Layer in the Filters
Stack pane. The Stack works similar to the Layers or History palettes in Photoshop. At the
bottom of the Filters Stack is your original image. Each Filter you select in the Library will
replace the Filter on the currently selected Filter Layer. 

You can create as many Filter Layers as needed.

 

   
You move forward and backward in time by selecting different Filter Layers in the Stack. 

For example, if you had a Filter Stack with the original and three Filter Layers applied, you could go back to the first Filter by selecting it in the Filters
Stack. The second and third Filter Layers will appear disabled and your preview will show only the results of the original with the first Filter Layer applied.
You can then click on the third Filter Layer, the most recently applied, and the second and third Filters will appear active again and the preview will show
the results of all three Filters. The results of each Filter Layer in Perfect Effects are cumulative, so the results of the first Filter are passed to the second
Filter and so forth. 

It is best to work with Perfect Effects in a step-by-step process, knowing that the results from each step are the starting point for the next Filter. This
means that when selecting the Filters to apply, think about the workflow order you use.

It is best to make color and tonal adjustments first, followed by special Filters and finish with final touches such as vignettes and sharpening. Thinking of
the proper steps to add Filters in Perfect Effects will give you better and faster results.
 

 

Using the Filter Stack
The Filter Stack is a list of all Filters and presets added to an image.



Changing the Current Filter

When you start in Perfect Effects, there will be an empty Filter Layer on top of your original.
Your original is at the bottom of the Filter Stack. To add an Filter to the empty Filter Layer,
select it first, then click on an Filter thumbnail in the Filters Browser. You can change the Filter
in a Filter Layer by clicking a different Filter thumbnail in the Filter Library.

Adding Filters

To add another Filter Layer so you can stack multiple Filters, click the Add button at the bottom
of the Filters Stack. This creates a new empty Filter Layer. Then select another Filter from the
Filter Browser. 

You can also double-click on an Filter in the Filter Browser to place it in the current Filter Layer
and add a new empty Filter Layer above it. 

Hiding Filters

A Filter may be temporarily hidden or revealed by pressing the Eye icon next to the Filter in the
Stack. When you hide a Filter, you are not removing it from the Stack. You can reveal it again
anytime. Keep in mind that hiding a Filter in the middle of the Stack may take a moment to re-
render and update your preview.

Changing Filter Order

Filters may be reordered in the Stack by clicking and dragging them into the desired position.
Reordering Filters can have a huge difference on the results of the image. Reordering Filters
will cause the Stack to re-render which may take a few moments.

Deleting an Filter

You remove a Filter by selecting it and pressing the Delete button at the bottom of the Filters
Stack or by pressing the delete key on your keyboard.

Tip: You can clear all the Filters from the Frame Stack at once by option (alt on
Windows) clicking on the delete button.

   

Adjusting the Opacity

The Layer Opacity slider controls how the selected Filter blends with the previous Filter or the original image. You adjust the opacity for any Filter by
selecting it and then adjusting the layer opacity slider. Adjusting the opacity slider effectively adjusts the strength of a Filter. For example, if you add a
black and white conversion Filter, sliding the layer opacity down will reveal some of the color from the previous state. Usually, the opacity slider will be set
to 100% when you add a Filter, however with some Filters like vignettes and soft focus Filters, it may be automatically set at 50%.

Adjusting the layer opacity slider to greater than 50% will make the Filter stronger, while adjusting it to less than 50% will make the Filter weaker. 

Blending Options

Clicking on the Blending Options arrow will drop down the Blending Options. This window offers
advanced blending options between Filters. 

 

   
The blending options controls are:   



Blending: A pop-up list of blending modes. The list includes normal, lighten, darken, screen, multiply, softlight, hardlight, overlay and color.

Apply Filter To: A pop-up list of color or tonal ranges will appear, only one may be selected. The options are; all, highlights, midtones, shadows,
reds, greens, blues, magentas, cyans, yellows, flesh colors, vivid colors and neutrals. This applied Filter creates a selection based on the lightness, hue, or
saturation range specified. There is a Fuzziness slider associated with this control that adjusts the hardness or precision of the selection. The range is zero
to 100.

Custom:  Select the Dropper tool and click on the image to sample a custom color range.  

Protect: The protect sliders are used to remove an Filter from a specific color or tonal range. The sliders are; highlights, shadows and skin. The selection
created should be feathered and appear natural. The default for these sliders is zero; the range is zero to 64. The range for Flesh Colors is zero to 100.

Reset: This resets all settings to the original default settings.



Perfect Effects has its own image-processing engine. This allows you to control the settings for many
filters down to the smallest detail. 

There are 23 Filters that do all the work in the full version of Perfect Effects. The Free version
provides a sampling of nine of them. Stacking and blending these filters will create different effects.
These filters are accessed in the Filter Options pane or the Browser

The Filters are:

Adjustable Gradient
Adjustment Brush
Black and White
Borders
Glow
HDR Look
Texturizer
Vignette
Vintage

 

   

Adjustable Gradient

Adjustable Gradient makes it fast to add common adjustments to a portion of the image. Adding the
Adjustable Gradient will automatically activate the Masking Bug. This is used when you want to apply
a custom filter to a particular area of an image. 

Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Compression: Compresses the tonal scale to reveal highlights and detail.
Detail: Enhances the details by increasing the micro contrast.
Warmth: Makes the image warmer or cooler.
Vibrance: Controls the vibrance or saturated the colors appear.
Glow: Adjusts the image glow.
Type: Sets the style or blending for the glow.

Reset will return the settings to the default.

  

   

 

Using Filters



 

Adjustment Brush

The Adjustment Brush filter lets you paint-in common adjustments just where you need them.

Preset Icons: Shortcuts to the most popular presets.
Presets: Pop-up that lists all built-in presets for the filter.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Compression: Compresses the tonal scale to reveal highlights and detail.
Detail: Enhances the details by increasing the micro contrast.
Warmth: Makes the image warmer or cooler.
Vibrance: Controls the vibrance or saturated the colors appear.
Glow: Adjusts the image glow.
Type: Sets the style or blending for the glow.
Reset will return the settings to the default.

Reset will return the settings to the default.

 

When you add an Adjustment Brush, nothing appears on your image until you paint it in
where you want. 

 

   

 



Black and White

The black and white effect is used to turn a color image into a monochromatic image. 

Preset: A preset menu drop down full of popular looks.
Filter: Simulates placing a colored filter over your lens when photographing with black and
white film. It works like a channel mixer, choosing the percentage of each channel to use.
Brightness: Adjusts the overall brightness of the image.
Contrast: Adjusts the overall contrast of the image.
Auto:  Selects the Black and White points automatically.
Highlights:  This slider darkens the highlights recovering detail.
Shadows:  This slider lightens the shadows revealing detail.
Whites:  This slider adds more contrast to the whites.
Blacks:  Adds more contrast to the blacks. 
Detail:  Enhances the fine details.
Toner: A drop-down list of darkroom toners which add a subtle color tint to the image.
Highlights:  Click on the color square to select the highlight toner color. The Amount slider
controls the strength of the toner color on the highlights.
Shadows: Click on the color square to select the shadow toner color.   The Amount slider
controls the strength of the toner color on the shadows. 
Swap Colors: Pressing this button swaps the highlight and shadow colors.
Preserve Whites and Blacks: When on, this checkbox keeps the pure whites and blacks
neutral instead of taking on the color of the toner.
Film Grain: A drop-down list of Film Grains from popular black and white films.  Amount slider
is for controlling the strength.  Size slider adjust the scale of the grain. 

Reset will return the settings to the default.

 

   

 



Borders

Adds authentic looking borders.

Preset:  Drop down menu of popular borders.
Category: Sets the category.
Border: Selects which border to add.
Mode: Sets the blending mode for the border.
Opacity: Sets the strength or opacity.
Hue: Sets the hue of the border.
Saturation: Sets the saturation of the border.
Brightness:  Sets the brightness of the border.
Thickness: Sets the thickness of the border.
Fit Image: Adjusts the size of the image under the border.
Button icons (right to left): Rotate clockwise 90 degrees, rotate counterclockwise 90
degrees, flip vertically, flip horizontally.

Reset will return the settings to the default.

 

   

Glow

This filter adds a soft focus glow to the image. 

Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu with a list of glow presets.
Amount: Controls the overall strength of the glow.
Halo: Sets the fuzziness or radius of the glow.
Style: A drop-down menu to set the style or blending. 
Warmth: Controls the temperature of the glow.
Saturation: Adjusts the saturation of the image. 

Reset will return the settings to the default.

 

   



 

HDR Look

This filter recreates the HDR style of tone mapping. 

Preset Icons: Presets for a quick adjustment.
Preset: A drop-down menu with a list of HDR presets.
Compression: Compresses the tone to reveal highlight and shadow detail.
Detail: Increases the local contrast.
Clarity: Increases the global contrast.
Highlights: Recovers detail in the highlights.
Shadows: Recovers detail in the shadows. 
Vibrance: Adjusts the vibrance of muted colors. 
Glow: Adds a bright glow.
Grunge: Adds a dark gritty look.

Reset will return the settings to the default.

 

 
   

Texturizer

This filter places a texture over the image to add a stylized look. When loading a texture file, it will be
rotated automatically to match the orientation of the destination image layer. The user can override
the rotation with the rotate and flip tools.

Preset: A drop-down menu of all the Texture presets.
Category: Sets the category.
Texture: Selects the specific texture type.
Mode: Sets the blending mode for the texture.
Opacity: Sets the strength or opacity.
Hue: Adjusts the Hue of the texture.
Saturation: Controls the saturation of the texture.
Brightness: Adjusts the brightness of the texture.
Scale: Changes the size of the texture.
Rotate & Flip Icons: Rotates or flips the texture.

Reset wil return all the setting to the default. 

 

   



Vignette

The vignette control allows the user to darken or lighten the edges of the image.

Preset Icons: Presets for quick adjustments.
Presets: A drop-down menu of all the Vignette presets.
Brightness: Controls how light or dark the vignette is.
Size: Controls the size of the midpoint of the gradient. 
Feather: Controls the hardness of the edge of the vignette.
Roundness: Controls the shape of the vignette square to round.
Style: This drop down menu will allow you to select either a normal, subtle or soft vignette.
Center Tool: This tool allows you to select the center point of the vignette.  Click on the
tool icon to activate and then click on the area in the image you wish to make the center. 

Reset will return all the setting to the default.

 

   

Vintage

The vintage filter is for adding an aged, vintage look reminiscent of films and papers for the late 20th
Century. 

Preset Icons: Presets for quick adjustments.
Preset: A drop-down menu of all the Vintage presets.
Style: A drop-down menu of various color styles.
Amount: Controls the overall strength.
Saturation: Adjusts the saturation of the original image.
Film Grain Amount: Adds film grain to the image.
Film Grain Size: Controls the grain size.

Reset will return all the settings to the default. 

 

 



You can think of masking as painting with black paint on white
paper. 

A white mask reveals all the filter that the mask is attached to.
An all white mask is considered blank or empty and shows all
the selected filter. As you use the masking tools, you are
adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current filter, allowing the filter(s)
under it to show through. Think of it like cutting a hole in the
mask. If you make a mistake, you can switch your paint color to
white (Paint-In mode) and paint the filter back in like an eraser.
When you paint you have more than just white or black, but
any shade of gray in between depending on the opacity of the
brush. Shades of gray partially hide the layer, blending the
layers together. 

Each filter layer in Perfect Effects has a mask automatically
added to it. This allows you blend each filter differently.

There are several global masking options that can be accessed
from either the masking Tool Option Bar or the Masking Menu.
They affect the entire mask on the selected filter layer.

Reset Mask

Reseting a mask returns it to all white. The entire layer is
visible.

Invert Mask

Invert swaps the white for black and black for white. What was
hidden is now revealed and vice-versa. Inverting a mask can be
very useful. It allows you to paint a layer in, rather than out,
which is handy if you only want to work with a small area.

Copy and Paste Mask

Perfect Effects allows you to copy the mask from one filter
layer to another. This is handy if you have painted a complex
mask on one layer for an adjustment and you wish to use the
same mask on another layer for a different adjustment. To
copy or paste a mask, use the Copy Mask and Paste Mask
commands from the Masking menu.

 

 

Using the Masking Tools
Perfect Effect users can choose the Masking Brush or Masking Bug to selectively apply each filter to the image. This opens a whole new world of control for
Perfect Effects. Using the Masking tools is just like using a layer mask in Photoshop to hide or reveal the filter in specific, user-defined areas of the image. The
Masking tools even support pressure-sensitive Wacom tablets for the ultimate in control. 

 

Paint-In Effects

Some of the filters in Perfect Effects are designed to be painted-in. When you add them to your
image, you will not see the image change, but the Masking Brush will be selected automatically.
Simply paint where you would like the filter to be applied.

You can identify Paint-In filters by the paint-brush icon in the upper left corner of the thumbnail.
Most of the Paint-In filters are located in the Basic Brushes category.

 



The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.   A close-up of the Mask View Modes

 

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

                         

   

   

Mask-
Red
The
masked
area
appears as
50% red.
This is
similar to
the Quick
Mask view
in
Photoshop.

 

Mask-
White
The
masked
area
appears as
solid white.

Mask-
Dark
The
masked
area
appears as
90% black.

 

Mask-
Grayscale
The
masked
area
appears as
black. The
unmasked
areas
appear as
white. This
is the same
as viewing
a layer
mask in
Photoshop.

 

Mask Modes
Mask Mode allows you to view your image mask in several ways.

 
Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several
modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are examples of the
different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard shortcut.



The Masking Brush is one of two tools in Perfect Effects for masking filters. When
you select the Masking Brush, your tool icon changes to a circle that represents
the size of the brush. It may also appear as two concentric circles (see below),
indicating the inner hard edge and outer soft edge of the brush if the feather
control is set above zero. There is also either a plus or minus in the center of the
brush. Minus means the brush mode is set to paint-out, plus means it is set to
paint-in.  

How to use the Masking Brush
 
To use the Masking Brush, select it in the tool well. Make sure you are on the effect you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying effect(s) appear.
If you make a mistake while brushing you have several options to correct them:

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.

How to control the Masking Brush

The Masking Brush Tool Options Bar

Paint Mode
The paint mode controls is you are Painting-Out (hiding the effect) or Painting-In (restoring the effect). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily. 

Invert Mask
Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask by pressing the Invert button in the
Tool Options Bar.

Reset Mask
Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.

Brush Size
You can control the size of the brush using the Size pop-up in the Tool Options
Bar. You use a small brush at high magnification for precise work, and a large
brush at fit to screen for general work. To the right, you can see examples of
brush strokes at varying sizes. You can control the size of the brush several
ways:

Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

 

 

Using the Masking Brush

 
The Masking Brush: The Masking Brush functions like a brush tool for masking layers. 

 



Feather
You control the amount of feathering or hardness of the brush by using the
Feather pop-up in the Tool Options Bar. The feather has a range from 1 to 100
percent. You use a small feather at high magnification for precise, hard-edged
work and a large, soft-edged brush at fit to screen for general work. You can
visually see your feather by watching the outer concentric circle of the brush tool.
To the right you can see examples of different feather options. You can control
the size of the brush several ways:

Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [  ] ).

 

Opacity
You can control the opacity, or strength of the brush with the Opacity pop-up in
the Tool Options Bar. Think of the opacity as the shade of gray you are painting
with. The opacity has a range from 1 to 100 percent. You use a high opacity to
paint quickly and hide large areas. You use a lower opacity for blending areas
together or for subtle work. To the right you can see examples of different
opacity options. You can control the size of the brush several ways:

Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.
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Perfect Layers supports pressure sensitive Wacom tablets. When you use the
Masking Brush you can enable pressure sensitive controls for the brush size,
brush opacity, or both simultaneously. Click on the W button next to each control
in the Tool Options Bar to activate the pressure sensitive controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right
you can see examples of how pressure sensitivity can be used to control the
Masking Brush.

 

 



Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from
being applied across edges. A great of example of using the Perfect Brush option
would be to mask a sky along a horizon of mountains.

 

Tip: You can turn the Perfect Brush on and off using the command or
control -r keyboard shortcut. You can also temporarily lock the color to
remove by holding down the control key(win) or the command key(mac).
This is useful when brushing through areas with a lot of openings like
tree branches.  

 

 



The Masking Bug is perfect for tasks like darkening skies, creating vignettes and graduated filters. Learning to use the Masking Bug is fast and easy. All the
adjustments made with the Masking Bug are live and readjustable until you press apply. 

Masking Bug Tool Options

 

Using the Masking Bug

 Masking Bug: This is used for blending layers by creating Radial, gradient, and reflected gradient mask shape quickly.

The Tool Options Bar for the Masking Bug includes the options shown above and detailed here:

Preset: The preset pop-up includes several common ways to use the Masking Bug. These presets change the current Masking Bug to match the preset
Shape: The shape pop-up controls the shape of the Masking Bug. The shapes are center, edges, gradient and reflected gradient.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new Masking Bug using the current settings.
Delete: Deletes the current Masking Bug
Reset: Resets the mask on the layer completely. This removes all Masking Bugs and clears and brushing that has been done.

Adjusting the Masking Bug

Start by adding a Masking Bug to a layer by clicking on it or pressing the Add button. Then set the Mask View mode to Mask - Grayscale. This will let you
see the Masking Bug in simple black and white.

Move: Click the large circle and drag.
Size: Adjust the size of the masking bug by using the solid line
Feather: Use the dashed line to adjust the feather or hardness of the mask.
Rotate: The handle of the center circle will rotate the mask.

Reflected Gradient Gradient 

Center Edges 

 



 Working with Multiple Masking Bugs

You can use up to six Masking Bugs per layer. Each Masking Bug is re-editable
until you hit Apply and save your image. To add another Masking Bug, to create
a complex mask shape, press the Add button or click outside of the current
Masking Bug while the Masking Bug tool is selected. 

Only one Masking Bug may be adjusted at a time. This is the active Masking Bug.
You will see the overlay controls for the active Masking Bug while your mouse is
over the preview area. Inactive Masking Bugs are marked with a small circle. You
can select an inactive Masking Bug by clicking on this small circle marker.

Masking Bugs are subtractive. Each Masking Bug hides more and more of the
current layer. When Masking Bugs overlay each other they may hide more of the
layer too. You can always use the Masking Brush to over-ride and paint areas
back in hidden by  the Masking Bugs.

 



 

Presets
Presets store the Effect Stack and all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent
results. You can save your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

 

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

 

Deleting a Preset

You can remove a preset from Perfect Effects if you no longer want to
have access to it. To remove a preset, follow these steps:

1. Open Perfect Effects.
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

 

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect Effects the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Effects.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Portrait, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONEffects extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Perfect Effects Free

About Perfect Effects Free: Opens the about box. This dialog contains your
serial number, version number and information on contacting onOne Software
for support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

 

File

Save & Close: Applies the current effect Stack and options to your image and
returns to the host application.

Cancel: Cancels Perfect Effects and returns back to the host application with no
changes.

 

    

Edit

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Cut: Cuts the current text into the clipboard.

Copy: Copies the current text into the clipboard.

Paste: Pastes the content of the clipboard.

Reset All: Resets all the floating palette controls back to their default settings.

Preferences (Windows Only): Opens the Perfect Effects preferences dialog.

 

    

Mask

Invert Mask: Inverts the mask, what was hidden is revealed and vice versa.

Reset Mask: Resets the mask to plain white.

Copy Mask: Copies the mask.

Paste Mask: Pastes the mask.

Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool overlay.
This has no effect on the image, just how obvious the Masking Bug tool is on
screen.

 

   

 

Menus



Preset

Save Preset: Saves the current Effect Stack as a new preset.

Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.

Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit the name, author or
description information.

Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.

 

View

Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.

Zoom Out: Zooms the preview window out one increment. This will make the
preview image smaller.

Fit to Screen: This sets the preview image so that the entire image is on
screen at once. Think of this as an overview of the entire image. This is the
setting you will use most of the time.

Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.

Show Browser Pop-up: Enables the browser pop-up window.

Select Filter Automatically: This will apply the first filter in each category
automatically. 

Browser Mode: Allows the user to select how the Browser Library displays the
categories.

Show Clipping: Shows the clipping overlay view, which over-rides
the current mask view.

Show Preview: Toggle to enable or disable the preview.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.

Show Mask: Allows the viewer to see the mask.

Mask View Mode: Allows the user to select the various mask modes.

 

   

Window

Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.

Filter Stack: Hides or shows the Filters Stack pane.

Filter Options: Hides or shows the Filter Options pane. Filter Options is only
available in Advanced mode.

Open Quick View Browser: This toggles open your quick view browser. 

Show Browser Panel: Hides or shows the Browser Panel.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the open
image.

 

   



Help

Search: Mac OSX only. Searches the menus options.

Perfect Effects Online Help: Opens this html Help in your default web
browser.

Video Tutorials: Opens the online Video Tutorial in your default web browser.

Getting Started: Opens the getting started overlay.

Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for  Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.

About Perfect Effects (Windows Only): Opens the about box with the
version number and license code displayed.

Help Improve onOne Products: Opens the Improve onOne Products dialog.

    



 

Keyboard Shortcuts
Perfect Effects has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action  Mac  Win

 Apply return  return

 Cancel  esc  esc

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Cut  cmd x  ctl x

 Copy  cmd c  ctl c

 Paste  cmd v  ctl v

 Invert Mask  cmd i  ctl i

 Save Preset  cmd shift s  ctl shift s

 Zoom In  cmd +  ctl +

 Zoom Out  cmd -  ctl -

 Fit to Screen  cmd 0  ctl 0

 Actual Pixels  cmd opt 0  ctl alt 0

 Next Browser View Mode  cmd b  ctl b

 Show Clipping  opt j  alt j

 Show Preview  cmd p  ctl p

 Preview Modes
  - Single Image
  - Left/Right
  - Left/Right Split
  - Top/Bottom
  - Top/Bottom Split

cmd Y
cmd L
cmd opt L
cmd T
cmd opt T 

ctl Y
ctl L
ctl opt L
ctl T
ctl opt T 

 Show Mask  ctl m  alt m

 Navigator/Loupe/Histogram  cmd 1  ctl 1

 Filter Stack  cmd 2  ctl 2

 Filter Options  cmd 3  ctl 3

 Show Browser Panel  cmd left arrow  ctl left arrow

 Show Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Fullscreen Mode  cmd ctl f  F11

 Keyboard Shortcuts  cmd shift k  ctl shift k

 Select Masking Brush  b  b

 Select Masking Bug  m  m

 Select Hand Tool  h  h

 Select Zoom Tool  z  z

 Zoom-In  cmd +  ctl +

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Toggle Perfect Brush  cmd r  ctl r

 Brush Size  larger ]
smaller [

larger ]
smaller [

 Brush Feather softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
opt ]
opt [

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
alt ]
alt [

 Enable or Disable Perfect Brush  cmd r  ctl r

 Toggle Tool Mode  x  x



 Temp Select Hand Tool  spacebar  spacebar

 Temp Toggle Tool Mode  hold opt  hold ctl

 Temp Toggle Clipping View  j  j

 Preview on/off  cmd p  ctl p

 Show Quick View Browser  cmd up  ctl up
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paint in effects   
Paint Mode   

 

����

����

����
����

����
����

����
����
����

����

����
����

����

����
����

����

����

����
����

����

����

����

����

����
����

����
����

����

����
����

����

���� ����

����

����
����

����

���� ����
���� ����
����

����

����
����



paste mask   
PDF   
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presets   
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Registration   
reset mask         ,

S
Save As   
Saving   
saving a preset   
sharing a preset   
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